UNIT 7 and 8
INSTRUCTOR'S MANUAL

PROGRAMMING

The material in these units are fairly complicated, because it covers
using RSLogix 500 programming software in detail and then introduces
the steps for operating the PLC. It will take the students time to
become comfortable moving around within a program using the
software. Allow ample time for these units; extra class sessions may be
necessary.

. The latter part of the experiment requires the students to enter a series
of commands using the RSLogix software. Since the students have not
yet learned about specific element addresses, they must refer to
Appendix B for the needed information. Prior to the Experiment you
may want to review the location of information in this manual.
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UNIT 7

INTRODUCTION TO PLC COMPUTER PROGRAMMING

Objectives

Upon completion of this unit the trainee will be able to:

1. Identify and describe the components of the three subsystems that make up the
MicroLogix PLC Training System.

2. Explain symbols and instructions used to program ladder logic into the MicroLogix
PLC Training System.

3. Describe the events occurring during an operating cycle.

4. Enter, run and monitor a sample program using the computer software.

Background

The Allen-Bradley MicroLogix programmable logic controller system consists of three
subsystems: an IBM-Compatible computer using Microsoft’s Windows based operating
system; a 1761-CBLPMO02 interface cable; and a MicroLogix PLC Training System
featuring the Allen-Bradley 1761 — L16BWA processor. Figure 7-1 illustrates the
components of the MicroLogix PLC Training System.

The MicroLogix PLC Training System can be programmed using two methods. The first
uses the PC based software, RSLogix 500, on an IBM-compatible computer. The second
uses a handheld programmer (HHP), often referred to as a Teach Pendant. Procedures
described in this section and chapter to follow, pertain to programming with the RSLogix
500 Software only.
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IBM Compatible Computer. The RSLogix 500 Software enables an operator to
program the SLC500 or MicroLogix family of processors. Hardware and system
requirements for programming using the RSLogix 500 software are a Pentium III or
better processor, 256 MB or more of RAM, 100MB of available hard disk space, and a
VGA Monitor.

1761-CBLPM02 Interface Cable. An RS-232 to PLC interface cable is required to
establish communications between a personal computer and the MicroLogix processor.
One of the cable of the interface cable is connected to the RS-232 port of the personal
computer. The other end of the cable plugs into the MicroLogix programmer connection
behind the little door on the frond left side of the MicroLogix PLC body.

MicroLogix 1000 Processor. By selecting the appropriate processor, 1/0, and voltage
types, the PLC system can be specifically configured to accomplish a particular
application. The MicroLogix 1000 used to activate, monitor, control and terminate the
laboratory exercises in this manual vuses the 1761-LI6BWA as standard. The 1761-
L16BWA has 10 DC Inputs and 6 relay Outputs with incoming AC line voltage.

Ladder Logic Program. The ladder logic program entered into the controller’s memory
via the RSLogix500 software and interface cable will contain instructions representing
external Input and Output devices. It will also contain some of the following
instructions:

Relay Logix (Bit) instructions,
Timers and counters.

Comparison instructions.

Move and logical instructions.

Bit shift and sequencer instructions.
Other instructions.

o e o

As a program is scanned during controller operations, the changing ON/OFF status of the
external Inputs will be applied, energizing and de-energizing external Qutputs according
to the particular instructions in each ladder Logic Rung.

Operating Cycle. During controller operations, the MicroLogix processor executes the
Ladder Logic instructions individually, rung by rung, to the end of the program. As it
does, it updates status bits according to the new instructions. This is called a scan and is
repeated many times a second. An operating cycle consists of two parts: Program scan
and the I/O scan (See Figure 7-2).

In an I/O scan, the data associated with external Outputs is transferred from the Output
file to the Output terminals. In-addition, Input terminals are examined and the associated
status bits in the Input data file are change according to the new instructions.

In a program scan, the updated status of the external Input device is applied to the user
program. The processor executes the entire list of instructions in ascending rung order.
Status bits are updated according to logical continuity rules as the program scan moves
from instruction through successive ladder rungs.
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The I/O scan and program scan are separate, independent functions. Any status changes
occurring in external Input devices during the program scan are not accounted for until
the next I/O scan. Similarly, data changes associated with extemmal Oufputs are not
transferred to the Qutputs until the next I/O scan. The only exception to this process
occurs when the immediate Input and immediate Output instructions interrupt the
program scan.

PROGRAM SCAN VO SCAN

Figure 7-2



Questions

1.

b2

List the three subsystems of the MicroLogix PLC Training System.

a. IBM-Compatible Computer.

b. 1761-CBLPM02 interface cable.

¢. MicroLogix PLC trainer with a standard 1761-L16BWA processor.

List two ways to programming the MicroLogix PLC.

a. Software.

b. Hand-held Terminal.

What are the computer hardware and system requirements for programming with the
Rockwell RSLogix 500 software?

Pentium IIT Computer with 256+ MB of RAM, 100 MB available hard drive

_space, Windows, VGA Monitor, and Interface Cable.

What is the function of the 1761-CBLPMO02

The 1761-CBLPMO02 interface cable establishes a communications link from the

computer through the RS-232 port (serial port) to the MicroLogix processor.

Describe the standard I/0 configuration of the 1761-L16BWA MicroLogix processor.

The 1761-L16BWA has 10 DC Inputs and 6 relav Qutputs. Other Microl.ogix

Processors have different 1/O configurations.

List six types of instructions programmed into ladder logic rungs.

Instructions representing external Input and Output devices: relay logic (bit)

instructions; timers and counters: comparison instructions, move and logical

instruction; bit shift and sequence instructions.
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7. Describe what happens during an operating cycle.

An operating cvcle consists of two parts: Program Scan and O Scan. The

processor_evaluates each rung ome at a time, Instructions are executed

individually, rung by rung to the end of the program. At the end of the program

scan, the processor controls the output devices according to their output data file

bits. Input instructions determine the conditions under which the processor will

make an output instruction true or false.

The ¥/O scan and program scan are separate independent functions. Normallv,

any status changes occurring in external input devices during the program scan

are not accounted for until the I/O scan.
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UNIT 8

RSLogix PROGRAMMING

Objectives
Upon completion of this unit the trainee will be able to:

Describe the features of RSLogix software.

ldentify and explain the project menus used in RSLogix.
Describe the steps in using RSLogix programming software.
Identify backup and recovery file methods.

Identify data entry Shortcut techniques.

Add, change and delete a ladder branch.

Explain the “UNDO” operation.

e IRl o

Background

Before widespread use of personal computers, Programmable Logic Controllers were
typically programmed using a handheld pendant. As personal computers became more
commonly used in industry, sophisticated PLC computer programming software was
developed. These software packages (e.g. RSLogix 500 by Rockweli Software for
programming Allen-Bradley SLC500 and MicroLogix PLCs) continue to become more
powerful with each new update of the software.

By programming the PLC via a personal computer, the user is able to take advantage of the
vast capabilities of the computer. Thus, creating, viewing, changing, saving, and monitoring
ladder logic is much easier to accomplish. This leads to the development of better software

and hardware control systems for operating and controlling industrial equipment and
processes.

Using RSLagix

The RSLogix 500 software is a Windows-based ladder logic programming package for the
SLC 500 and MicroLogix processors.

Features of RSLogix 500 software include:

A free-form ladder editor

A project verifier

Drag-and-drop editing

Search and replace capability

Data Monitoring

A point-and-click interface

Trending and histogram functionality
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When you open a project in RSLogix 500 you can expect to see:

A project tree. Contains all the folders and files contained in your project.

The ladder view. This is where you view and edit your ladder logic.

The results window. Displays the results of a search or a verification procedure.

The menu bar. Select functionality from the menus.

The online bar. Learn the operational mode.

The standard icon bar. The standard icon bar contains many functions that you will
use repeatedly as you develop and test your logic program,

The tabbed instruction toolbar. Displays instruction mnemonics in tabbed categories.
The status bar. Displays ongoing status information or prompts.

Start Up Steps

The following steps explain how to get up and running quickly with RSLogix 500 as soon as
you install it.

Step 1 m Configure RSLinx:

1. Open RSLinx
2. Click on Communication and select Configure Drivers...

3. Use the puli down menu under Available Drivers: select RS-232 DF1 Driver
4. Click Add New... and click OK

5. Confirm Comm Port, usually COM1 and select Auto Configure and select OK
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6. Close Configure Driver window
7. Double click on AB-DF1




8. You should see the processor on the right side

‘xa\.\,ﬂockwell Software RSLinx Lite - [RSWho - 1]

% Fle View Communicabions Slaon Window Help 2 EEE)
| S18)
W Aucbiowse  [_eren | 22 @ Browsing - node 1 found
= ™ Workstation, DEFAULT 4| —
H-25 Linx Gateways, Etherm g
25 AB_DF1-1,DH-485 00 o1

o3 AE_DF1-1, DH-48 DFi-COM1  UNTITLED
=1 00, Workstation, Df = |/

4] i 2
For Help, press F1 I INuM{ T31/01/00 {0113PM

9. Minimize RSLinx
DO NOT CLOSE

Step 2 m Conficure RSLogix:

Open RSLogix500

Click on Comms and select System Comms...
Under Current Settings change Driver to AB_DF1-1
Select Who Active...

S
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5. Double click on the Micrologix
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6. Select Apply and OK
7. On the left side of RSLogix500 next to Driver should be AB_DF1-1.
Important: You must install RSLinx to configuring RSLogix 500. See Figure 8-1 for details.

Step 3 m Configure System Communications

Do this before you begin a new project. The settings you establish with this step will remain
with the project and will be applied when you attempt to download any logic program. From
the Comms menu, click System Comms. Then click the System Communications tab on the
System Options window. From this tab select your driver, node, and timeout.

Example of one computer system setup:

Driver AB_DF-1
Processor Node i
Reply Timeout 10 Sec.

Step 4 B Create a New Project or Open an Existing Project

New Projects

RSLogix 500 is based on projects. Projects are the complete set of files associated with your
program logic. You create a project from the File menu by clicking New. RSLogix 500
prompts you for the type of processor you will communicate with. The Select Processor
Type window will open. In this window scroll down to Bul.1761 MicroLogix 1000 click and
select OK. The project tree on the left side of the screen is your access point to Program,
Data table, and Database Files.
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Existing Projects

From the File Menu, click Open. Use the dialog that appears next to Open a ladder logic
project and/or its associated database.

When you have the Open file window opened, press F1 for help that can assist you with
clarification of the different file types and their extensions.

Step 5 m Create Project and Data Table Files

The project tree is your point-of-entry for creating new files or accessing existing files. To
create a new file, right-click the program or data file icon and then select New from the
menu. You will be prompted for information about the file.

Program files contain controller information, the main ladder program, and any subroutine
programs.

Data table files contain the status information associated with external 1/0 and all other
instructions you use in your main and subroutine ladder program files.

Step 6 m Define Chassis and Modules
After you have opened a project, your PLC hardware is defined here.

The MicroLogix 1000 is a fixed PLC. It does not require setting up. 1f you have a modular
PLC you must define the cards in the PLC rack. You perform these procedures in the 1/0
Configuration window. Access this window by double-clicking the 1/0 Configuration icon in
the project tree. Then click a module in the list on the right side of the window and drag it
into the slot where you want it to reside.

Example: Model MB6355 MicroLogix 1000 PLC Training System: 1761 MicroLogix 1000

Step 7 m Enter a Logic Program

When you open a program file by double-clicking its icon in the project tree, the ladder file
opens in the right half of the RSLogix 500 window. Usually program file #2, the main
program file, will be opened when you open a project. If you have not begun to enter any
ladder logic, only the end rung will show.

Click on the end rung and then select the new rung icon from the user toolbar. To place an
instruction on a rung, click its icon on one of the toolbars.

You can place several instructions on a rung in sequence by clicking the icons one after
another, RSLogix 500 places instructions from the left to right.
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RSLogix 500 supports a file-based editor. This means that you can:

Create and/or edit multiple rungs at a time.
Enter addresses before you actually crate data table files for your 1/0.
Enter symbols before you have assigned addresses for them in the database.

Enter instructions without having to provide addresses until just before file validation
oceurs.

To add addresses just click an instruction and then type the address in the empty field that
appears above the instruction. With RSLogix 500 you can also drag and drop addresses from
a data table file onto instructions in your ladder logic.

Step 8 m Add Documentation to vour Logic Instructions

You can use several methods to add symbols and descriptions to addresses in the database.

Open the program file and add the documentation directly to the addressed
instruction. Use the right mouse menu for this.

Modify an address’s assigned documentation in the data file. Double-click the data
file in the project tree, and then click on an address within the grid that appears on the
data file dialog. At the bottom of the dialog there are files were you can enter the
documentation for the address.

Modify the database using the database editor. Double-click an icon in the database
folder located in the project tree.

Enter a symbol directly and later assign an address to the symbo! using the database
symbol / description editor.

Step 9 m Verify the Program Logic

When you are ready to build your project, you can validate a single program file or
you can validate your entire project. Use the menu bar or the right mouse button
menu to initiate this process.

After you initiate verification, the Verify Results output window displays and gives
you information about mistakes or omissions that may have occurred with your
program logic.
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Step 10 m Configure Communication Channel, Download, and Go Online

See figure 8-1 for Communication Channel Setup using RSLinx.

After a program has been written, verified and saved, download the program from the
computer to the PLC to run the program. After you download the program you can
then go online. Once you are online you can put the PLC into the run mode and run
your project. In the Processor Status pull down menu you are able to do a verity on
commands such as: go online, go offline, download, run,...

Step 11 m Monitor Data Files

You can use RSLogix 500 to watch what is happening in your data table files. This
procedure is called monitoring data table files.

Double-click the data file icon in the project tree that contains the data you want to
monitor. You can have multiple data table files opened for monitoring at the same
time. Just drag each data table window into viewing position by clicking on the title
bar and moving the mouse.

Step 12 m Search and Replace Instructions

The Find option allows you to quickly locate instructions, addresses, and symbols (if
they have been defined) in ladder program files. 1f you want to automatically replace
instructions and addresses with different ones, you can use the Replace option. You
can use wildcards in your find and replace operations.

Begin any find or replace operation by selecting that functionality from the Search
menu. Then type the mnemonic (X1C, TON, etc.), the address (B3:0/4, etc.) or a
combination of both mnemonic and address (XIC B3:04) or mnemonic and symbol
(XIC REPEAT) for the instruction you want to locate in the Find What text box.

Step 13 m Print a Report

When you need a printed copy of what you have done in RSLogix 500, you can
select which reports you want to print from the Report Options dialog. Select this
dialog from the File menu.

To preview the way a ladder file will print, click Preview. You can scale up the
image to make the instructions appear larger on the printed page or scale down the
image so that, in cases where many instructions are on a rung of logic, all the
instructions can fit on the printed page.
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Backing Up Your Work

Remember to backup your work as you develop your ladder logic programs. RSLogix 500
uses two types of backup files that you can access at anytime, and provides you with an auto-
recovery file in the case of a power failure. All of these files contain the entire description
database associated with the project.

| Auto-Backup files are created automatically each time you save a project. You can
preset how many backups should be retained for any project by entering a Number of
Backups in the Preferences tab of the System Options dialog. Reach this tab from the
Tools menu. Then Click Options and select the Preference tab. Auto-backup files
(saved as .RSS files) have the letters BAK and a series of numbers (000 to 999)
appended to the filename. For example, an auto-backup created for project
TEST.RSS might be identified as TEST_BAKO00.RSS, and a more recent backup
might be identified as TEST BAKO001.RSS.

| Compressed Format Backup Files are typically generated for archiving or giving to
another user. Compressed format backup files include the .RSS and all database files
for the project compressed into a single .RS1 file. From the File menu click Backup
Project to generate a compressed-format backup file.

Crash Recovery

If you experience a power interruption, RSLogix 500 provides you with a recent backup file
containing current edits.

RSLogix 500 automatically creates file backups while you are working with a project and
when you save the project. This auto-generated recovery file (internal RSS file} is only
available to you the next time you open a project if you have a system crash or your power is

interrupted. After attempting to open a project after a power failure, RSLogix 500 prompts
you with choices.

You can open:

] the auto-saved file, insuring retention of any edits made before the power
interruption.
| the last backup that you made, when you selected Save before the power interruption.

You must have saved or closed the file you are working on at least one time for the auto-
recovery process to work. Therefore, it is good practice to save the file immediately after
beginning a new project. This insures that your auto-recovery process can begin properly.

You can set the interval time at which auto-recovery saves of your project will occur. Do
this by making a setting in the Preferences dialog. The auto-recovery process insures that
you will be able to retain any work that had been done on the file between the time of the
power interruption and the last manual save.
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Quick Entry Technigues

Mapping

To make your programming tasks faster, RSLogix 500 lets you map any available alphabetic
key (A-Z) on your computer keyboard to a ladder logic programming instruction.

From the View menu, click Properties. Then click Quick Key Mapping to access the
mapping list. Make sure you have a program file window opened and active or you will not
be able to select Properties from the View menu.

You can jump to any rung in your project by clicking the Search menu, and then clicking
Goto. You can go to a rung in the current program file or you can go to a rung in another
program file within the same project.

Keyboard users can press the [Ctri + G] key combination to access the GOTO Rung dialog.
Shortcut methods exist for most editing functions within the RSLogix 500. You can access

this list of shortcuts in the online help by searching the word “shortcuts” in the online help.

Addressing

There are several different methods that you can use to address instructions. You can enter
an address by:

= manually typing it in
[ dragging addresses from the data files
] using copy and paste from program to program

You can drag-and —drop rungs, branches, instructions, and addresses from file to file or from
the database to a file. To drag-and-drop, position the mouse pointer over a file element,
click and hold down the left mouse button and drag the element to another location, and then
release the mouse button. Red boxes indicate valid locations; these turn green when
properly selected.

Branching

Add a Branch

Click icon on the instruction toolbar to place a branch in your ladder logic. 1f your cursor is
on an instruction, the branch is placed immediately to the right of the instruction. If your
cursor is on the rung number, the branch is placed first on the rung.
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Move a Branch

Click on the upper left comer of a branch to move the entire branch structure to another
location in your ladder logic program.

Expand 2 Branch

Click. the right leg of the branch, then drag the leg to the right or left. Valid release points
will be visible on the ladder display.

Nested Branches

Place the cursor at the upper left corner of a branch leg, click the right mouse button, and

select append New Branch to place another branch structure within the original branch
structure.

Parallel Branches

Place the cursor at the bottom left corner of a branch leg and click the right mouse button to
Extend Branch Leg Up or extend Branch Leg Down.

Copy Branch Leg

Click on the left edge of the branch leg you want to copy. This is a center leg. Then click
copy in the right mouse menu. Finally click on a rung or instruction in your logic and click
paste from the right mouse menu to insert the rung leg.

Copy Entire Branch Structure

Select the right leg of the branch structured, then click copy in the right mouse menu. Finally

click on a rung or instruction in your logic and click paste from the right mouse menu to
insert the rung structure.

Delete a branch

Place the cursor at any location on the branch and click the right mouse button. Then click
Delete. If you cut or delete a branch, all instructions on the branch are also deleted.

UNDO Operation

The UNDO reverses your last action. You can use this UNDO to walk through (and UNDOQ)
your previous actions one at a time. RSLogix 500 remembers up to 200 previous actions.

If you want to UNDO a move operation, you must click UNDO two times. This is because
RSLogix 500 considers a move a series of two actions (copy and cut). You have to let
RSLogix know that you want both the copy and the cut undone. If you click UNDO only
one time when trying to UNDO a move, the move appears to be a copy, and you will see the
moved element appear at both locations.
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EXPERIMENT

Purpose

To programming MicroLogix PLC Trainer Ladder Logic

Procedure

1. Enter RSLogix 500 use the mouse to press the Windows *“Start” button,
select the Programs folder. In the Programs folder select the Rockwell
Software folder. Select the RSLogix 500 folder, point to the RSLogix 500
Icon in this folder and press the left mouse button once.

!Q

From the “File Menu” select “Open” to edit an existing file, or “New” to open
a new file.

3. Ensure that the program is in the “Offline” mode by checking the “Online
Bar” in the upper left-hand corner of the screen. The “Online Bar” should
read “Offline”.

4, Use the vertical scroll bar, or the down arrow key to move to the end of the
program.

5. Select the “User” Menu in the “Instruction Tool Bar”. Point at the *New
Rung” key at the left end of the tool bar and press the left mouse button one
time. Note: use the floating tool tips window to help identify key functions.

6. Add the input elements to the rung of ladder logic by selecting the ][ key from
the tool bar. Enter I:1/5 for the address.

Important: You cannot add an instruction to the “END” rung.

7. Add the output element to the rung of ladder logic by selecting () key from
the toolbar. Enter O:2/5 for the address.

8. Verify the rung by pointing the mouse to the left-hand side of the rung and
click the right mouse button. Select “Verify Project Rung™: to verify logic
and accept the rung.

9. Save the file by first selecting the “File Menu”, then selecting “Save™.

10. Exit the program by first selecting the “File Menu”, then selecting “Exit”.

For additional information on using the RSLogix 500 Software, refer to the HELP
files / documentation, shipped with the software.

8-11



Questions
1.

b2

What is the purpose of RSLINX ?

RSLINX provides communication between the PLC and the RS LOGIX
programming software

What “drivers” do you use with RSLINX?

RS-232 DFI

What “drivers” do you use with RSLOGIX?

AB_DFI-1

Explain the editing and monitoring differences between “ ONLINE” and
”OFFLINE “ when using the RSLOGIX software.

In the “OFFLINE" mode you have full program editing capabilitv but no

monitoring ability.

In the “ONLINE " mode vou have full program monitoring capability but very

limited editing abilitv.

This PLC training system uses which Allen-Bradley processor ?

1761 Micrologix 1000

What is the advantage of “MAPPING” ?

Mapping makes programming tasks easier by assigning kevboard kevs to
ladder logic programming instructions

What is “BRANCHING “ ?

Branching is a ladder logic wav of placing multiple instruction elements in
parallel on a single rung.

What is the “UNDO operation ?

Undo allows the user to reverse his last kevstroke action.
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